LOGGING INTO THE DOMINICAN NETWORK
What Are All Those Icons I See When I Click on “My Computer”? ............................................. 1
Safe “Driving” Habits .......................................................................................................................... 4
Accessing Your Network (N: ) Drive From Off-Campus: ............................................................... 6
Why Can’t I Get That MPG File From My N: Drive? ..................................................................... 6
Connecting to the Dominican Network Using Your Own Laptop ..................................................... 7
Wireless Access to the Dominican Network .................................................................................... 7
Network Authentication on a Wireless PC ......................................................................................... 7

USING DOMINICAN’S EMAIL ................................................................................................. 8
Accessing Your Email from On- or Off-Campus ......................................................................... 8
Logging Off ....................................................................................................................................... 9
Why Can’t I Send (Or Receive) Certain Email Attachments? ......................................................... 9
File Size ........................................................................................................................................... 9
File Type ......................................................................................................................................... 9
I Received a Message from Information Technology Asking to Send my User Name or Password in
Reply ................................................................................................................................................. 13
I Received a Legitimate Message Indicating My Allotted Email Space Is Full—Now What? ....... 13
Enabling AutoArchive—Desktop Users Only .................................................................................. 14
How Do I Generate Those Automatic “I’m Out of the Office” Messages? ............................ 14
Generating “Out of Office” Messages for Off-Campus Users ......................................................... 14

Using Our Web-Based Resources ............................................................................................. 15
Learning Management Systems .................................................................................................... 15
myDU LMS ...................................................................................................................................... 15
Blackboard LMS ............................................................................................................................ 16
Which One Do I Use—myDU or Blackboard? ............................................................................. 17
Class Rosters and Online Grade Submission .............................................................................. 19
Retrieving Your Class Roster ......................................................................................................... 19
Submitting Final Grades Online: This is IMPORTANT, Everyone! ............................................ 20
Web Pages ...................................................................................................................................... 21
Syllabi for Classes ......................................................................................................................... 22
Converting a Word Document to HTML Format for the Web ...................................................... 22
Can Students Have Web Pages? .................................................................................................... 23
Accessing Your I: Drive from Off-Campus .................................................................................. 23

Podcasting, Clickers, and Blogs, Oh My!: Other Classroom Technology Available ............... 24
Wikis and Blogs .............................................................................................................................. 24
Podcasts ......................................................................................................................................... 25
Taking Over Student Machines .................................................................................................... 27
SmartBoards .................................................................................................................................... 27
"Clickers" ....................................................................................................................................... 27
Cart of iPod Touches ....................................................................................................................... 28
Cart of Laptops or Netbooks .......................................................................................................... 28

Other Video Options .................................................................................................................... 28
Camtasia Studio ............................................................................................................................. 28
Video Cameras ............................................................................................................................... 29
Web Conferencing .......................................................................................................................... 29

Software Information .................................................................................................................... 29
What Software Packages Does Dominican Support? ................................................................. 29
How to Learn More About Supported Software Packages ........................................................... 30
What Software Is Loaded Where? .................................................................................................. 30
How to Get Specific Software Needed for a Class ................................................................. 30
How to Obtain Copies of Software or Computers for Personal Use........................................ 30

Computer Classrooms ......................................................................................................... 31
How Do I Get a Computer to Use in the Classroom Just for Myself? ...................................... 31
How Do I Get a Classroom With Computers for Each of My Students? ................................. 32

IT Help Desk Web Site ........................................................................................................ 33
LOGGING INTO THE DOMINICAN NETWORK

All Dominican faculty members are required to obtain a network account. Yes, that includes adjunct faculty, too. The primary reason for this is that Dominican email is an official method of communication for the University. Many important messages from the Office of the President, Office of the Provost, etc., are sent to Dominican email addresses. In addition, it is expected that you will communicate to your students using their official DU email account, since that is the only way to ensure that it is being sent to an account that is theirs and theirs alone. (Besides, it helps keep things legal so far as FERPA regulations are concerned.) For online courses, it is required that you use your Dominican account and your student's Dominican accounts for communication. This is to stay compliant with the Higher Education Opportunity Act. There's another benefit to this requirement: a DU network account is the only way you will have access to the incredible array of full-text article databases our library subscribes to from off-campus.

All faculty should have an email account created for them already. (If you have not, contact your School.)

myDU
Almost everything you need technology-wise or, indeed, Dominican-wise will be found via our myDU site at http://www.dom.edu/mydu. Information Technology-specific information can be found via the Resources tab, and then the link for Information Technology.

When you have your user name and password, you can go to any Windows-based office or laboratory computer to login to our network. (We will discuss how to access the network from home later in this document, starting on page 6.) Most likely, the first screen you will see upon turning on a PC will be a “Welcome to Windows” screen asking you to press CTRL+ALT+DELETE to logon. After doing so, you will see a screen such as this:

In most cases, your User name: is the first letter of your first name followed by your entire last name. So, if your name is Sally Johnson, your user name would be sjohnson. After typing it in, press the Tab key on your keyboard to move down to the Password: field or just click with your mouse in the Password: box. Note that your Password is case-sensitive.
If you have a login screen that shows a box labeled **Log on to**, as shown below, that is Windows’ way of asking for a domain name. In our case, the domain name is **DOM**. This should be there by default:

Click **OK**, and you are now logged into the Dominican University network!

*Wait a Minute! My Screen Looks Nothing Like These Shown Here!*

Information Technology will be updating SOME computers from *Windows XP* to *Windows 7*, primarily in the Technology Center and some classrooms. It’s possible your screen will look a bit different.

**CAUTION: REMEMBER TO LOGOFF WHEN FINISHED!!!**

Even in the privacy of your office, you should *always* LOGOFF of the network whenever you are finished with your work. With all of the security concerns around higher education today, you can’t be too careful about giving access to your network drive, your computer’s hard drive, your email, etc., to anyone who happens to stumble into your office while you step away “for just a moment.” On a less malicious note, staying logged into the network is one of the leading causes of the “*my computer isn’t working this morning*” service calls that the IT help desk receives. If a network server should go down for some reason overnight, it can wreak havoc on a computer that has remained logged in.

To logoff, click the **Start** button on the Windows desktop, and then click the command **Log Off**, as shown here:

(Some computers will also have the ability to LOCK the screen with a screensaver.)
You will then see the following confirmation screen:

![Log Off Windows Confirmation Screen]

Simply click Log Off, and you will be back at the Windows screen prompting you to press CTRL+ALT+DEL.

**Should I turn off my PC every time I leave the office?**

It is generally best to NOT turn off your PC when you leave the office—just log off the network as described above. One reason for this is that from time to time, Microsoft issues various security updates to the Windows operating system. Our IT department will “push” the most critical updates out to your machine, which requires that your machine be turned on, though not logged in. While there will often be an email alert ahead of time to whenever these critical updates are due, it’s probably easiest just to leave your PC on all of the time.

**RESTART YOUR PC FROM TIME TO TIME!**

While we don’t recommend turning off your PC, we highly recommend restarting it every now and again—perhaps about once a week or so. Whenever your computer is slower than usual or just plain unresponsive, this is the best thing to try before you start threatening it with various unspeakable acts. To do this, click the Start button, and then select Log Off:

![Restart Confirmation Screen]

From the following screen, make sure you specify Restart—not Shutdown, which would, of course, turn OFF your machine!
What Are All Those Icons I See When I Click on “My Computer”?  

After logging in, double-click on the My Computer icon on your Windows desktop if you want to would like to see all of the things you now have access to on the network. It will look something like this:

The Local Disk (C:), DVD-RW Drive (D:), and Removable Disk (E:) are drives that are on your own machine, while the others are on our network. You will either have to click once over each of the above icons to see the full drive name, or select a different “view” of the drives (see screenshot above for how to do this), such as the “tile” view.

So….what do all these do? The table below gives a brief explanation of each, though these may vary a bit depending on the “rights” you have on the network and whether or not you or your school/department is involved in using shared documents across the network:

---

IT Help Desk: ext. 6888 (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. Information Technology staff will NEVER ask you for your user name or password via email.
<table>
<thead>
<tr>
<th>Drive Letter</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:</td>
<td>Local Disk</td>
<td>This will always be the hard drive in the computer you are using.</td>
</tr>
<tr>
<td>D:</td>
<td>DVD-RW Drive</td>
<td>A writable DVD drive. Not all computers will have these; as some will have read-only DVD drives (DVD-ROM).</td>
</tr>
<tr>
<td>E:</td>
<td>Removable Disk</td>
<td>This will be for a USB flash drive. Your computer may have several of these, so this letter may change depending on which are being used.</td>
</tr>
<tr>
<td>H: (sometimes J:)</td>
<td>Shared on ‘fileserv’</td>
<td>Directories shared by members of various academic departments. This is one place your office may keep documents. This is a secure environment—you will not have access to any folders that you do not have rights to under the login you are using.</td>
</tr>
<tr>
<td>I:</td>
<td>yourusername on ‘fileserv\facultyweb’</td>
<td>This is a web drive that corresponds to an internet server we have located at <a href="http://dom.in.dom.edu">http://dom.in.dom.edu</a>. (Think of the letter I: for your drive as standing for ‘internet.’) This is where your web pages should be saved. If you would like to put your syllabi on a publicly-accessible web site that does not require a login, this is the place to put them. Your document must be converted to HTML format first to be viewed on the web. <em>Word</em> allows you to do this by clicking the Office Button ( ) then Save As, and then by selecting Other Formats, and in the ensuing dialog box in the Save as type: area, selecting the Web Page format. (Do NOT use “single file web page,” as this is incompatible with many browsers. We have additional instructions on page 21.) <em>Anything on this drive will be accessible via the web; however, only you have rights to add, delete, or change the contents of items on this drive. You should not put anything that is of a private or secure nature on this drive, since we are “Googled.” You have a 500MB limit of space on this drive. You can also add/delete items on this drive from home; see page 23 for details.</em></td>
</tr>
<tr>
<td>N:</td>
<td>yourusername on ‘fileserv\faculty’</td>
<td>This is your network drive. (Think of the letter N: for your drive as standing for ‘network.’) This is where you can safely save your files and, in fact, is the preferred place for saving your files rather than the hard drive (C:) on the computer itself. Local hard drives can and will crash, and any crash will, of course, come at the most inopportune time possible. Network drives can crash too but here’s the difference: our network drives are backed up constantly and are duplicated on a separate array of hard drives. NO ONE else has rights to this directory or can even see it (other than our network administrators). Unlike your I: drive, you can safely place private items on this drive. You have a 500MB limit of space on this network drive. Plus, this drive is accessible to you from off-campus; see the next section for details.</td>
</tr>
<tr>
<td>P:</td>
<td>New Pibbles_ver9 on ‘Admin2k’</td>
<td>Used by folks who rely on our Jenzabar administrative software package. As a faculty member, you can likely ignore this drive altogether, though chairs may have some access to material here.</td>
</tr>
<tr>
<td>S:</td>
<td>FacultyShared on ‘fileserv’</td>
<td>A shared directory used primarily by instructors in computer science-related fields where students can retrieve needed files for programs or an assignment as well as submit them back to the instructor. One drawback: these are not accessible from off-campus. Therefore, if possible, we recommend use of either our myDU or Blackboard learning management systems as a place to store files for student use.</td>
</tr>
<tr>
<td>W:</td>
<td>Web on ‘fileserv’</td>
<td>If your department keeps some files on our internet server at <a href="http://dom.in.dom.edu">http://dom.in.dom.edu</a>, this is where they will be placed. This is NOT the place to store your own personal web-based material, however—that’s what the I: drive is for.</td>
</tr>
</tbody>
</table>
Safe “Driving” Habits

Disconnect Your USB “Flash” Drive Correctly
To avoid data lose on your USB drive, do NOT simply yank it out of the PC. Instead, hover your mouse over the little “green arrow” icon that is on the so-called system tray, right near the time on the lower right-hand corner of the desktop on your PC. You should see the words Safely Remove Hardware when you hover your mouse over it. Click on this icon. You will then see the words Safely Remove USB Mass Storage Device. Just click again and you’ll soon see a confirmation message that it’s safe to remove your USB.

Save Frequently/Back Up Often!!
Unless you are particularly fond of having to re-create all of your documents from scratch, we strongly encourage you to make back-up copies of your documents. If you save items on a USB drive, keep a spare on your network (N: ) drive. Also, click that floppy disk (Save) icon frequently when editing any document or file. Remember, the network drive IS backed up by Information Technology on a regular basis, and should be your first choice for backing up critical material.

Accessing Your Network (N: ) Drive From Off-Campus:
If you need access to files you left on your network (N: ) drive and forgot to save it onto a USB for taking off-campus, you will be able to retrieve those files from home. Information Technology has great documentation on doing this task for Windows XP, Windows Vista, and Windows 7 users, as well as Macintosh users. The documentation is available at:

https://jicsweb1.dom.edu/ics/Resources/Offices_-Departments/IT/Forms/

Or by going to the Information Technology page on myDU, and clicking the link on the left for Forms and Information.

Before doing this, however, please note that this is not encrypted over the Internet. Therefore, it is not recommended for files of an extremely sensitive nature, such as financial information, documents with your credit card number on them, etc. (Of course, it goes without saying you should not be using anything with a social security number on them at all.)

Why Can’t I Get That MPG File From My N: Drive?
For security and bandwidth reasons, certain file types are blocked by our firewall. One reason is that these files can carry viruses more easily than others; also, it is to prevent widespread downloading of what could be commercial, copyrighted content. Among the common file types that you will NOT be able to retrieve from your N: drive while off-campus include files with these extensions: .bat, .com, .cpl, .mpeg, .pif, and .zip. An up-to-date, complete listing of blocked file types is available via the Information Technology page on myDU, clicking on the link for Connecting Personal Equipment to the Network on the left. On the ensuing page is a listing called Blocked File Types. For your N: drive access, the
listing to pay attention to is the first one, *Blocked On All Protocols*. (This listing also includes blocked file types for email attachments.)

### Connecting to the Dominican Network Using Your Own Laptop

You can bring your own laptop from home to connect in your office or elsewhere (wireless access is discussed below), but **you must have an up-to-date virus scanner AND have the latest security patches**! If you do not have antivirus software installed, we have a copy of Norton available to Dominican users at: [http://updates.dom.edu/patches/](http://updates.dom.edu/patches/). To make sure you have the latest Windows patches, visit [http://windowsupdate.microsoft.com](http://windowsupdate.microsoft.com). If you are running an Apple operating system, you must have all Critical Patches installed. If you are missing any or are not sure, please run the software update feature.

The first time you connect your own laptop, you will be prompted to run software called **Safe Connect**.

The above information (with links) is also available on the *myDU* page for Information Technology cited on every page of this document by following the link for **Connecting Personal Equipment to the Network** on the left.

### Wireless Access to the Dominican Network

If you are anywhere on the Dominican campus, odds are you have wireless access somewhere near you! The first time you connect wirelessly, you will have to go through **Safe Connect**, outlined below. Once that’s done, we have plenty of “hotspots” available. If you need some detailed help with making a wireless connection, our Information Technology team has great instructions on (where else?) the *myDU* Information Technology page cited throughout this document. Once on the page, over on the left you will see a link called **Connecting Personal Equipment to the Network**. From there, click the link for **Connecting Through Wireless**.

Wireless access is available in, basically, all **academic areas**. (Therefore, it is NOT available in the student residence halls.) This includes, for example, areas such as:

- Rebecca Crown Library (All Floors)
- Parmer Hall
- Lewis Hall
- The Grill

All wireless access points utilize 802.11b and 802.11g protocols.

### Network Authentication on a Wireless PC

The first time you login to the network via a wireless hotspot, you will be redirected to a network authentication site and be prompted to download and install the software agent, **Safe Connect**. This is for your protection and ours, as it is designed to prevent “infected” computers from accessing our network. We have detailed information on this procedure on *myDU* via the Information Technology page.

First, login to the network by entering your Dominican username and password in the login box you will see. Please note that you may receive multiple security messages during the login process. In order to ensure that you login properly, choose “Yes”.

---

**IT Help Desk:** ext. **6888** (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. **Information Technology staff will NEVER** ask you for your user name or password via email.
Once your username and password have been verified, you will be prompted to download and install the software. **This will only happen on your first login.** Follow the on screen prompts to download and install. There are no setting changes required.

After the installation is completed, an icon will appear in your system tray (the lower right part of your screen, by the clock).

Once installed, an access method will appear. If it does not, right click on the icon in your system tray and choose **Login**. Enter your Dominican username and password.

The software installed will validate your system configuration to ensure that your operating system has all required patches and that you have an antivirus installed and up to date. If validation is successful, you will be logged onto the network.

If validation is not successful, you will be given directions on how to remediate yourself. Depending on the security updates required, you **may** need to reboot your computer several times.

If you still cannot connect to the network, contact the IT HelpDesk at X6888.

### USING DOMINICAN’S EMAIL

Dominican uses *Microsoft Outlook* as its email program. By having for a network account (see page 1), you will have email access set up. Be sure to contact Information Technology to have your Outlook account set up if you have not already done so (ext. 6888 from on-campus; 708-524-6888 from off-campus).

#### Accessing Your Email from On- or Off-Campus

If you have your own office on campus with your own PC (not shared with anyone else), Outlook 2007 should be installed on the PC. Once you double-click the Outlook icon on your desktop, getting to your email is easy: just click on the **Inbox** icon on the Outlook toolbar, and you will see all of your unread mail.

If you want to get your email from **off-campus**, or if you are an adjunct faculty member and either share an office or do not have your own office space, you can access your email using the internet. This can be done from home, from the Technology Center on campus, from the Library.....anywhere there is web access. Be aware that we do **not** support the Safari web browser for this function: only Internet Explorer and Firefox are to be used.

The quickest access email is from myDU’s **Campus News** page, where there is a link to **Dom.edu Email** over on the left. Alternatively, you can use the following URL and make it a “Favorite” at home:  
**http://mail.dom.edu/exchange**.

**Macintosh users**: note that you will have the most success navigating our email using the **Firefox** web browser.

---

**It is important to note that beginning in the **Fall 2008** academic term, incoming **students** have an email address that ends with **@my.dom.edu**, and they will be using a different address to access their email, namely **http://www.exchangelabs.com/owa**. This does not affect faculty members, but you may want to be aware of this for the benefit of your students.**

---

IT Help Desk: ext. **6888** (708-524-6888 from off-campus) or visit website listed on top of page to submit help ticket.  
**Information Technology staff will NEVER ask you for your user name or password via email.**
From off-campus, you will next see a dialog box pop up on the screen prompting you for your Dominican network user name and password.

**If you are having difficulty getting the dialog box, try disabling any popup blockers you have.**

For the **User Name**: type in your *entire* Dominican email address, including the @dom.edu. So, if your user name is rjohnson, you would type in rjohnson@dom.edu. Next, type in your Dominican network password. (Note: this is your *network* password you picked when creating a network account, NOT your myDU PIN, which is different.) You will then see the web-based version of Outlook.

### Logging Off

Be sure to click the **Log Off** button in the web version of Outlook when finished! (It’s towards the upper right-hand portion of the screen):

![Log Off button](image)

Additional help on using Outlook is available from IT’s page on myDU by following the link for **Outlook Information**, in the **Services IT Provides** section (on the far right of the page).

### Why Can’t I Send (Or Receive) Certain Email Attachments?

Regardless of whether you are accessing our email from on-campus or off-campus, you may sometimes have difficulty receiving email attachments from others, or may have your colleagues complain that they are not receiving email attachments from you. There are likely two reasons for this: file size and file type.

An up to date listing of all blocked file extensions is available in myDU via the Information Technology page by clicking the link for **Using Your Personal Equipment on Campus** over on the right, under **Services IT Provides**. On the ensuing page is a link to **Blocked File Types**.

### File Size

The largest file attachment our email server can receive or send out is limited to approximately *ten megabytes* (10 MB; or 10000 KB). If you need to send or receive something larger than that, contact our Help Desk at ext. 6888 if on-campus, or 708-524-6888 if off-campus.

### File Type

Almost everyone has heard about how computer viruses are spread via email attachments; if not—welcome to the 21st century and the wonderful world of people destroying other people’s computers. For fun. Many an unsuspecting user has double-clicked on an email attachment and—*presto!*—gets an instantly malfunctioning computer. For that reason, any email attachments with the file extensions

---

**IT Help Desk:** ext. **6888** (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. **Information Technology staff will NEVER** ask you for your user name or password via email.
listed on the following page will be “caught” by our firewall. These types are particularly notorious for containing executable files that may spread a virus.

Since some of the file types are ones that you may want for various computer-related purposes (such as the Access database file extension .mdb or .zip files) or in programming classes, we suggest you employ one of our learning management systems (myDU or Blackboard) to have your students turn in assignments through the system rather than via email. These file types will NOT be blocked when used within a learning management system. We also have detailed instructions on a “work around” for dealing with blocked file extensions for trusted files below, but this should only be used with people you trust.

A listing of all blocked file types is available here via the Information Technology page on myDU. Click the link for Connecting Personal Equipment to the Network on the far left, and on the ensuing page there is a link for Blocked File Types.

---

### A Possible Work-Around for Blocked Files

If you need to send or receive an email attachment that is one of these file types listed above, there is a potential workaround, IF you are certain the file is save and virus-free and you know your recipient/sender. The one that is most commonly requested to pass through the firewall is a .zip file. If you need to send a .zip file attachment to someone, we recommend that you change the file extension to one that our firewall will allow to pass through, such as .doc, which is the extension used for Word documents. You must, of course, notify your recipient that you have done this so that they, in turn, can change the extension back to .zip so that it can be used. Below is a step-by-step method for changing a file extension for those of you who may not know how. Examples are show using the Windows XP operating system that we have on campus; for those doing this from home using Windows Vista there is an explanation later, though with smaller screenshots, since the procedure is very similar.

#### Windows XP Instructions

**Step One: Make Sure You Can See File Extensions**

- Double-click on the My Computer icon on your desktop.
- Once there, click the Tools drop-down menu, and then Folder Options…
- In the ensuing dialog box (shown on next page), click the View tab.
- Uncheck the checkbox labeled Hide file extensions for known file types, and then click OK.

**Step Two: Rename Your File With a .doc Extension**

- In My Computer, navigate your way to wherever the file you want to send is located.
- Single-click the file name so that it is “highlighted.” (Be careful not to double-click, as that will open the file!)
- Click the File drop-down menu, and then Rename. Or, right-click over the highlighted file name, and choose Rename from the result context menu. (There should also be an option to Rename This File in the task pane on the right.)
- Click your cursor at the end of the file name, making sure the entire file name is not highlighted anymore, and carefully backspace over the existing file extension (anything after the dot), and then type in the .doc extension in place of the existing extension. Make sure you have just one dot still. (There is a screenshot of this on the next page.)
• You will get a message box on the screen, giving you a dire warning: if you change a file name extension, it may become unstable. Are you sure you want to change it? Go ahead and click Yes. Your file is now renamed, and ready to be sent as an email attachment.

In the Folder Options dialog box, click the View tab. Scroll down a in the Advanced settings area, and uncheck this box, and then click OK.
Windows Vista/Windows 7 Instructions

The steps are virtually the same in Vista and Windows 7, other than the very first one, though of course the screens look a bit different.

Step One: Make Sure You Can See File Extensions

- Click on the Start button, and select Computer from the listing on the right-hand column (on most systems).
- Once there, click the Tools drop-down menu, and then Folder Options...
- In the ensuing dialog box, click the View tab.
- Uncheck the checkbox labeled Hide file extensions for known file types, and then click OK.
Step Two: Rename Your File With a .doc Extension

- Still within the **Computer** listing of files, navigate your way to wherever the file you want to send is located.
- *Single-click* the file name so that it is “highlighted.” (Be careful not to double-click, as that will open the file!)
- Click the **File** drop-down menu, and then **Rename**. Or, **right-click** over the highlighted file name, and choose **Rename** from the result context menu.
- Click your cursor at the end of the file name, making sure the entire file name is *not* highlighted anymore, and carefully backspace over the existing file extension (anything after the dot), and then type in the .**doc** extension in place of the existing extension. Make sure you have just one dot still, as shown below:

![Image of renamed file]

- You will get a message box on the screen, giving you a dire warning: *If you change a file name extension, it may become unstable. Are you sure you want to change it?*. Go ahead and click **Yes**. Your file is now renamed, and ready to be sent as an email attachment.

I Received a Message from Information Technology Asking to Send my User Name or Password in Reply

Dominican University Information Technology Staff will **NEVER** request your user name or password via email. There have been multiple "spamming" attempts to do this over the past few years, and while our network firewall will catch most of these attempts before they reach you, some have trickled through with, alas, bad consequences for those who replied to it. If you get any message in your IN box asking for this information, forward it to helpdesk@dom.edu so that we can be aware of the situation.

I Received a **Legitimate** Message Indicating My Allotted Email Space Is Full—Now What?

First, see the section above. If this message is also asking you for your user name and password, do **NOT** reply to it. In fact, forward it to helpdesk@dom.edu. However, you may have received a legitimate message from us regarding this. (It will come from administrator@dom.edu, but still—**be careful**! Don't automatically trust it.) If so, check the following items:

- Have you deleted all the messages within your **Sent Items** folder?
- Have you deleted all messages that have accumulated in the **Junk E-mail** folder?
- Have you deleted all messages in your **Deleted Items** folder? (Are you noticing a theme here?) Much like the Windows Recycle Bin, anything deleted will stay here by default until you empty it on your own. (For office/desktop users of Outlook, this can be modified by clicking on the **Tools** drop-down menu, and then **Options** while in your IN box. Click the **Other** tab in the ensuing dialog box, and then check the box labeled **Empty the Deleted Items folder upon exiting**.)
- Are there any other folders you may have created in Outlook that you've forgotten about?
Next, check messages that have attachments. Since your email box is dependent on the size of the messages you have received, attachments can really add up after awhile. Save these attachments to your network (N:) drive or to your hard drive or USB.

If none of the above works, it may be time to turn on the Auto Archive feature in Outlook, so that all messages after xx number of days are moved to your N: drive. However, bear in mind that your N: drive space is also limited to 500 MB, so this solution may not work for everyone. Be sure to contact the IT Help Desk for assistance.

### Enabling AutoArchive—Desktop Users Only

Unfortunately, AutoArchive is NOT available for Web-only users of Outlook. If you only have access to the Web version of Outlook, you have little choice but to clean out your mailbox. (You can save an open message as a text file, if you want to, by clicking the File..Save As menu, and then specifying Text Only as the file type in the dialog box.)

To set AutoArchive, click the Tools drop-down menu, and then Options, and then click the Other tab in the ensuing dialog box. You will see an AutoArchive... button towards the middle of this dialog box. Click that button, and you will see a dialog box with a variety of options, most notably where you want the older messages to be moved, as well as how often. You may also choose to not Archive specific folders by right-clicking over the folder name, and then left-clicking Properties. There will be an AutoArchive tab on the ensuing dialog box, where you can click Do not archive items in this folder.

### How Do I Generate Those Automatic “I’m Out of the Office” Messages?

For desktop users, click the Tools drop-down menu, and then Out of Office Assistant... . You will then see a box to type your message within, and whether or not to turn it on. Web Outlook users will see a similar dialog box by clicking the tab on the left labeled Options.

The “Out of Office Assistant” will send automated replies only to people at Dominican. This is actually an intentional setting on the server, because many off-campus e-mail servers could treat such automated replies as spam and filter them out. Also, such automated replies are address verification for those wonderful people who send out spam. The autoreply is verification that an e-mail address exists, thereby opening the door for even more spam. If you absolutely want to send an automated reply to off-campus users, however, follow the steps immediately below.

### Generating “Out of Office” Messages for Off-Campus Users

The text box above explains why the “Out of Office Assistant” will not work for off-campus users. If you want to enable it so that off-campus users see that you are out of the office, you will have to create a new Rule in Outlook. The steps are a bit different depending on whether or not you have Outlook loaded on your PC or if you are using the web version.
Creating a Rule on PC Version of Outlook  (Does not apply to Web Version!)

In the Navigation Pane over to the left, click the Mail tab in Outlook so that you are in your IN box. Next, click the Tools drop-down menu, and then Rules and Alerts. Click New Rule in the ensuing dialog box, and then Start from a blank rule. At this point, the prompts you see are relatively self-explanatory, though when you get to the point it asks, be sure to enable have server reply with a specific message. One word of warning: unlike the “Out of Office Assistant,” where a person will only receive the AutoReply once, this method will generate an automatic reply each and every time a person sends you a message. If someone sends you ten emails, they will get this reply ten times. You should also be aware that many Internet Service Providers may (eventually) treat this as spam. You may want to consult the IT Help Desk, especially if your screen looks different.

Creating a Rule on the Web Version of Outlook

For the Web version of Outlook, click the Rules button on the left (just above Options), and then click the New button on the following screen. You can then follow the prompts on the form. However, since there is no option to have server reply with a specific message for every email that comes to you as there is on the PC version of Outlook, about the only viable option is to have the message forwarded to another email account. In other words, your sender will not get an automated message at all! Frankly, if you are going to do this, you might as well just check your Dominican email account, anyway!

Using Our Web-Based Resources

All of the resources discussed in this section are—one way or another—linked from the Campus News page on myDU, which is the default home page on all computers on campus. You can make the Campus News page a “favorite” in your browser at home, too: http://apps.dom.edu/campusnews/.

Learning Management Systems

Dominican presently supports two learning management systems (LMS): the LMS built into myDU, and a separate product, Blackboard. Both allow you to post course-related documents, homework assignments, web links, and even post grades using an online gradebook. (These grades are for you and your students only; they do not automatically go to the Office of the Registrar!)

myDU LMS

All faculty teaching a class should have access to a course site in the LMS in myDU as soon as the course schedule for the semester is available online. Depending on the semester that myDU is currently “set” to, you should have access to your current courses in myDU as well as past and future ones if the latter are part of the online course schedule. (Note that on the Home tab of myDU, over on the right under Course Schedules, you can see which term the system is set to by looking at Current Semester:.)

To access a course site, first make sure you login to myDU with your ID and PIN. Then, click the My Courses link under the Quick Links over on the left on any page in myDU. (There will always be Quick Links available, no matter where you are in the system once you login). Click on any of the course names you see, and you will immediately be in the LMS:
Accessing past or future courses requires a bit more hunting around. Click the Faculty tab at the top of myDU, and on the ensuing page scroll down to the area labeled All My Courses. You will notice that the default setting for the drop-down menu to the right of this area is Current Courses. Change that drop-down menu to either Past Courses or Future Courses. (Please note that Future Courses will likely not be available until registration for those courses has begun for students.)

As soon as you select one, the screen will immediately change. On the screenshot below—seen after selecting Future Courses, you will see future courses listed. Simply click on the course name of any and you will immediately by the LMS course site for the course:

Please note that the link called Gradebook that you see on the screen above leads to the Gradebook WITHIN THE LMS—which is not where you submit grades online to the Office of the Registrar. (Hopefully, this will be changing soon with a future enhancement of the LMS—but not yet!!)

We have complete documentation on using the LMS in myDU on (where else?) myDU in the Information Technology area. Once there, click on the link for myDU over on the right under the Services IT Provides heading. You will see a link for myDU LMS Documentation for Faculty on the ensuing page.

### Blackboard LMS

Blackboard is also available for faculty use. We are on the latest version—version 9.1. One important thing to keep in mind is our Blackboard server is NOT tied into any other system, so faculty must be acquainted with how students must “self-enroll” in Blackboard course sites, among other things.

Faculty accounts should have been created automatically, but if you don't have one, it can be created upon request by Information Technology. We will be offering several training sessions throughout the year, but we also have some instructional videos on some of the primary functions in Blackboard via the...
Information Technology page on myDU, and then by following the link for Blackboard over on the far right, under the Services IT Provides heading.

Which One Do I Use—myDU or Blackboard?

If you plan to upload Word documents, have online discussion forums, post some PowerPoint presentations, or maintain a gradebook, either LMS in use here will suffice. Each, however, have their own advantages and disadvantages. Listed below are some differences in certain features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>myDU</th>
<th>Blackboard</th>
</tr>
</thead>
<tbody>
<tr>
<td>Course creation for faculty</td>
<td>Automatic with issuance of your faculty ID and PIN, plus being the instructor of record for a course.</td>
<td>Not automatic; you must submit an IT Help Desk ticket to have your course created.</td>
</tr>
<tr>
<td>Cross-listed courses</td>
<td>Various work-arounds exist for dealing with Handouts and Forums, but this is an issue in myDU. Each course ID will have its own course site, so a class that’s cross-listed (for example: AMST and HIST) will have two sites. You must maintain the Gradebook and Attendance for each course due to the way the course is created in the system. For workarounds for Handouts/Forums, consult our PDF at: <a href="https://jicsweb1.dom.edu/ics/Resources/Offices-Departments/IT/Systems_at_DU/myDU_and_myCourses_Information.jnz">https://jicsweb1.dom.edu/ics/Resources/Offices-Departments/IT/Systems_at_DU/myDU_and_myCourses_Information.jnz</a></td>
<td>Not an issue, since one course site can be created with your request to the IT Help Desk.</td>
</tr>
<tr>
<td>Student enrollment</td>
<td>Automatic; tied into registration system. With cross-listed courses, however, students will initially appear only in the specific one they enrolled in.</td>
<td>Not automatic; students must self-enroll after the creation of their user name/password. Student accounts will be created with 24 hours after your class site is up on Blackboard. Students will use their DU network user name as their user name and their student ID number as their initial password.</td>
</tr>
<tr>
<td>Online gradebook</td>
<td>Quite flexible. It also includes the ability to add extra credit assignments and drop lowest grades. There is an issue with cross-listed courses, however (see above). Final grades for ALL courses must still be submitted separately to Office of the Registrar through a different myDU area (Faculty tab—Grade Entry).</td>
<td>Quite flexible. Can create and edit customized views, and with weighted grades one has the ability to drop lowest or highest grade. Can be slow to load, however, courtesy of reliance on Java. Final grades for ALL courses must still be submitted separately to Office of the Registrar through myDU (Faculty tab—Grade Entry).</td>
</tr>
<tr>
<td>Feature</td>
<td>myDU</td>
<td>Blackboard</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------</td>
</tr>
<tr>
<td>Attendance-tracking</td>
<td>Built into system via the Attendance portlet. Also ties into the Gradebook, so that times absent (or tardy) can affect grade</td>
<td>Not built into system specifically.</td>
</tr>
<tr>
<td>Download documents (for students)</td>
<td>Easily done via Handouts portlet, and you can organize groups into “sets”.</td>
<td>Easily done in any content area, as is creating folders. (There IS a security &quot;bug&quot; in Internet Explorer, however, that causes a yellow bar to appear on top of browser in Internet Explorer asking users if a file is okay to download.)</td>
</tr>
<tr>
<td>Changing the layout of a course</td>
<td>Easy via the Context Menus to create new menu items and you can move or remove portlets from each area.</td>
<td>Easy to click and drag around menu items and create new items. Most of these functions can be done &quot;on the fly&quot; with drop-down menus.</td>
</tr>
<tr>
<td>Discussion Boards - Ability to &quot;subscribe&quot; and receive emails when content is posted.</td>
<td>Built in. (Called &quot;Forums&quot; in myDU.) A User List feature makes it very easy to track the number of posts for each student. Also can &quot;subscribe&quot; and receive emails when content is posted.</td>
<td>Built in. You also have the ability to grade forums and then see number of posts. Also can &quot;subscribe&quot; and receive emails when content is posted.</td>
</tr>
<tr>
<td>Publisher-produced course &quot;cartridges&quot; that tie into texts</td>
<td>Ideally, publisher should have what is known as an IMS-compliant package. myDU accepts Common Course Cartridge, version 1. (Version 1.1 coming soon.) If the publisher allows you to use their own ZIP files, you may be able to import parts of it (documents, PDFs) into your course by adding the Course Content Import portlet to a page.</td>
<td>Built-in; contact your publisher's sales rep for download key. Usually, students are issued a special access code that is shrink-wrapped with the textbook. They use this access code the first time they login to the class. Also compliant with IMS packages (Common Course Cartridge, versions 1.0 and 1.1.)</td>
</tr>
<tr>
<td>Online submission of assignments (by your students) into the system</td>
<td>Available via the Coursework portlet and by specifying &quot;File Exchange.&quot;</td>
<td>Available via the Assignments feature within any content area. (Note: The Digital Dropbox has been removed from this version in favor of the Assignments feature.)</td>
</tr>
<tr>
<td>Online quizzes (automatically graded)</td>
<td>Available via the Coursework portlet and by specifying &quot;Online.&quot;</td>
<td>Available in any Content area via the Evaluate drop-down menu, and then Create Test.</td>
</tr>
<tr>
<td>Retrieving documents submitted</td>
<td>Via the Coursework area (see above). You can also download all submitted work at once as a ZIP file.</td>
<td>Via the Grade Center and the specific assignment. All assignments can be downloaded all at once as a ZIP file.</td>
</tr>
<tr>
<td>Feature</td>
<td>myDU</td>
<td>Blackboard</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Student Groups</td>
<td>Available; though somewhat cumbersome in implementation by having to use the Roles function.</td>
<td>Available and fairly easy to use; you also have the ability to create groups and assign students randomly.</td>
</tr>
<tr>
<td>Ability to view course sites as a student would</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Web 2.0 Features</td>
<td>There is a Blog portlet that you can add to any page via the Edit Page link. This also includes the ability to generate an RSS feed. (You can also request a course blog/wiki on our LiveDU server at the IT Help Desk. Though on a separate server, students can login with their network user name and password.)</td>
<td>Course blog available, though there is no RSS feed. There is also a student Journal feature that allows private interaction between instructor and student with the option to share it with class, as well as a class wiki feature.</td>
</tr>
</tbody>
</table>

### Class Rosters and Online Grade Submission

All class rosters are available online via myDU, as is the ability to submit final semester grades to the Office of the Registrar. In fact, paper format of either of these is no longer available: you must retrieve your roster online, and you must submit your final grades online.

#### Retrieving Your Class Roster

Log into myDU with your ID number and PIN. (If you forgot your PIN, you can always click the Forgot your PIN? link to the right of the login button. You will, at the very least, have to know your ID to get the system to retrieve your PIN. The PIN will then be emailed to your Dominican email address.) Once logged in, click on the Faculty menu item. Fortunately, the Office of the Registrar has posted information on how to retrieve your roster on this page, so the directions here basically repeat what is already stated on that screen.

For the current semester that is set in the system, all you have to do is check under the Faculty Course Control heading on this page. You should see all of your current classes, with a drop-down menu to the right in a column called Go Directly To. Simply select Class List from the drop-down menu for your class, and you will retrieve your roster:
“Now That I Have My Roster—Where’s My Class??”
To find out where your class is going to meet, the class roster should have this information at the top. The other place room information is accessible is by clicking on the View My Faculty Schedule link in the Faculty Course Control area. Finally, you can also find this via the Course Details choice in the Go Directly To drop-down menu shown above. (Just above Class List.) Room locations are often not finalized until just before the class meets.

To retrieve a future roster or to select a roster when the semester you are interested in is not the default setting in the system, click directly on the Faculty Course Control title you see on the screen. This will cause the Faculty Course Control portlet (as they are called) to maximize on the screen. Select the term you are interested in from the Term: drop-down menu, and then click the Search button. You will see a listing of all of your courses for that term. Simply select Class List from the drop-down menu in the Go Directly To column on the far right.

“What Do You Mean There’s No One Enrolled?!?”
Bear in mind that future class rosters will not be available until registration has begun in your School for the semester in question! For graduate programs, this is typically on a semester-by-semester basis. Rosary College students, however, often have the option of registering for the entire academic year the preceding spring.

Submitting Final Grades Online: This is IMPORTANT, Everyone!
The place to submit final grades online is also available via the Faculty menu item once you login to myDU. Once again, the Office of the Registrar has thoughtfully given you instructions on how to submit grades online on this web page, so the information below basically repeats what is already on that page.

Once in the Faculty area, you will see a section called Grade Entry. Click directly on the View Course List link just below that. Next, make sure you have the current term selected in the Term: drop-down menu—which it may not be, depending on when you are doing this. Select the correct term, and then
click the **Search** button. Finally, click on the link for the course for which you want to enter grades. Your class list is displayed, and a drop down box under the **Final Grade** column is presented for each student. Select the grade for the student and move to the next line. Repeat for each student. When finished, click **SAVE**. You will see your screen display a message that indicates for you to “Wait until complete”. You will receive the message **Grades Successfully Updated**.

Note that a grade of **W** will appear for students who have withdrawn from the course. No further action is required. Also, any student taking a course Pass/Fail will not have a complete list of grades under his/her drop-down menu, but only those options relevant. If you have any questions, concerns or problems with grade entry, please contact the Office of the Registrar at ext 6804.

**NOTE:** As soon as you submit your grades online, your students will be able to see them when they login to **myDU** to check their grades! And believe us, they will be doing that with great regularity after finals week!

---

**VERY IMPORTANT INFORMATION ON GRADES!!**

If you are using **either** the **myDU** learning management system OR **Blackboard**, the online gradebook is **NOT** tied into the Registrar’s online grade submission!!! You **MUST** go through the process outlined above to submit your grades!

---

**Web Pages**

All faculty (and students, for that matter) can have their own web space on a server. Faculty can submit an IT Help Desk ticket to have this done; students must complete an application to create a Web Account. (Copies of these forms are available in the Technology Center and can also be retrieved online via **myDU** in the **Information Technology** area by clicking **Forms and Information** on the left. On the ensuing screen you will see a link for **Web Account Application**.)

Once created, you will see a new drive on your computer when you login to our network—the **I:** drive. (Yes, we’ve made these names as easy as possible: the **N:** drive is your network drive, while the **I:** drive is your internet drive. Clever, huh?) However, since files on this drive are meant for use on the web, your web pages—or at the very least your “home” page where users go to first—must be in HTML format. Your home page must be named **index.htm**. Once created, your home page will be accessible for anyone via the following URL:

**http://domin.dom.edu/faculty/yourusername/index.htm**

So, if your name is Pat Johnson, your home page address will be:

**http://domin.dom.edu/faculty/pjohnson/index.htm**

Even though you have 500MB of file space available on this drive, don’t forget to periodically purge this drive of files you are no longer using.

---

All users—faculty and students alike—who put up web pages should look at our IT policies. You can view them by going to the **Information Technology** page on **myDU** by clicking on the link on the left for **IT Policies**.

---

**IT Help Desk:** ext. **6888** (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. **Information Technology staff will NEVER ask you for your user name or password via email.**
Syllabi for Classes

To put up a syllabus on the web, you have a couple of options. If you are using myDU, you can simply upload a Word document directly into the system following the instructions we have on our documentation on using myDU. (Available on myDU in the Information Technology area. From there, click on the link for myDU over on the right under the Services IT Provides area. On the ensuing page, you will see a link for myDU LMS Documentation for Faculty.)

However, putting up a syllabus on myDU means only those students enrolled in your class have access to that syllabus. Some Schools at Dominican want their faculty members’ syllabi available to prospective students, too. This means that such syllabi must be available to the “outside world” and this is done by placing them on your I: drive. Such syllabi are linked from myDU by following the link for Syllabi on the myDU home page under the Helpful Links area. This also means that your syllabus must be converted to the “web-friendly” HTML format. There are brief instructions on converting a Word document to HTML format below. However, note that the Brennan School of Business and the Graduate School of Library and Information Science maintain their own syllabi pages on myDU, so faculty in those Schools should check with them first.

For consistency, we strongly encourage you to name your various class syllabi index.htm and place them in folders by course number on your I: drive (such as engl101, hist101, art303, etc.). Please do not include spaces in folder names and follow the Registrar’s course numbering system. Once you’ve done this, a link can be created on your respective schools’ syllabus listing page by creating an IT help desk ticket, which is covered on page 33. If you follow the guidelines above, a syllabus will be accessible via the following address:

http://domin.dom.edu/faculty/yourusername/coursenumber/index.htm

So, if your name is Pat Johnson and you copied your syllabus into a folder for your English 101 course, the address to access it will be:

http://domin.dom.edu/faculty/pjohnson/engl101/index.htm

If you already know how to create a web page on your own, terrific. You can place the HTML file on your I: drive and get a link created. Otherwise, Word has a relatively painless way of doing it.

Converting a Word Document to HTML Format for the Web

First, be aware that not quite everything in a Word document is going to look the same once it’s been converted to the web-friendly HTML format. Spacing can get completely screwed up, for example. Before converting something from Word to the web, the following guidelines are suggested:

1. Do not use the Tab key. While converting a document to HTML will retain the tabs, depending on the user’s web browser resolution they may not appear as you had intended—especially if you are relying on things to line up properly. Also, what happens when the text wraps to the next line? It’s a mess. See the suggestion below.
2. Use Tables when you want things lined up. To get columns of text to line up properly—such as a course calendar—use tables! Not only will they convert to HTML format properly, but text in a table cell wraps properly. (Tip: you really should be doing this for your paper-based documents, too. The Tab key does wonders on messing up documents once you type a line that’s too long.)

When you think you are ready to convert your document to HTML format, it’s actually pretty simple. Click the Office button in the upper left corner ( ) and then click Save As and then finally Other.
Formats. In the ensuing dialog box, there are a few things to take care of, and we will work from the bottom up:

1. In the **Save as type** drop-down menu at the bottom, click the drop-down arrow at the far right, and select **Web Page (*.htm, *html will appear if you have allowed viewing of file extensions on your computer)**. Do **NOT** use the Single File Web Page setting! This will make your page all but useless for anyone who uses a non-Internet Explorer browser (such as Firefox). On the other hand, **Web Page, Filtered** is perfectly acceptable.

2. As soon as you do that, a new line will appear on the dialog beneath the file type called **Page Title**: . This allows you to set a title that appears at the top of the browser window in the blue title bar. It is **NOT** the same as the file name, and is not really required, but it’s a nice touch and will certainly help anyone identifying your page when using search engines, since this title field is what search engines display in their list of results. So, be a good “netizen” and click the **Change Title…** button and give your page a title.

3. Moving up again, in the **File name** area type in **index**.

4. In the **Save in**: area at the very top of the dialog box, click the drop-down arrow and find your **I: drive**. The full name will be something like **username on 'Fileserv/Facultyweb'** (I: ). However, if this is for a class, such as a class syllabus, click the new folder icon near the top right of the dialog box ( ) and create a new folder on your I: drive for the class number. So, if this were for your English 200 class, the new folder will be **engl200**. Once you create that new folder, you should automatically be placed within it.

5. You can finally click the **Save** button! Your page is now “live” on the web.

6. Or is it? To make sure the “outside” world can see it, fire up your web browser and type in the full address of the page—do **NOT** just double-click on the file name! If you followed the above instructions and your user name is rjohnson and you created a folder for engl200, the full address you should type in is: **http://domin.dom.edu/faculty/rjohnson/engl200/index.htm**

7. (Actually, part of the “magic” of using **index.htm** as the file name is that all browsers should default to that address, anyway. You can save yourself some typing and just ignore the **index.htm** when typing in the address altogether.)

### Can Students Have Web Pages?

Yes, they can, but **you should tell them this means it's viewable by everyone, and they must be careful with their content!** Your students will need to fill out an Application for Web Account form, available at the Technology Center’s lab assistant’s desk and also online in PDF format via the **myDU Information Technology** page by clicking the **Forms and Information** link on the left. The resulting page will have a link to the **Web Account Application**.

Much like faculty, once the account is created for students, they will have an I: drive. Students should name their home page **index.htm**. They can also create folders if they would like to have web pages for specific classes.

### Accessing Your I: Drive from Off-Campus

Your I: drive, remember, is automatically enabled for web browsing. However, how do you add files or change material on your I: drive from off-campus? Fortunately, you can access and add to files to your web drive from off-campus in similar fashion to how you access your N: drive. The steps for doing this, however, are a bit different. Information Technology has written documentation on the steps to access your I: drive from off-campus on their help site. Visit the **myDU Information Technology** page and then click the **Forms and Information** link on the left. The ensuing page will have to link to a document on **Accessing Your I Web Drive from Off-Campus**.

---

**IT Help Desk: ext. 6888 (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. Information Technology staff will NEVER ask you for your user name or password via email.**
Podcasting, Clickers, and Blogs, Oh My!: Other Classroom Technology Available

Our *LiveDU* server allows faculty to create blogs and wikis for courses, and best of all students do not have to remember a different login, since once the space on the server is established they can login with their Dominican network user name and password. In order to have a podcast, you need a wiki or blog, so we will start with those.....

**Wikis and Blogs**

You can contact the Information Technology help desk at ext. 6888 (708-524-6888 from off-campus) or create a new help ticket online to request the creation of a blog/wiki site. (The two are created at once.) Information Technology, in turn, will need the class number and name of the class for which you want to create a wiki and blog, as well the names of your students and their Dominican network (email) user names. The latter is to ensure that only your students (and you) have access.

Once created, you will have an account on the *LiveDU* server. The URL will be something like:

http://livedu.dom.edu/groups/yourclassnumber

You will retrieve a screen similar to the following. The wiki below, featuring Faculty Seminar podcasts from the Center for Teaching and Learning Excellence (yes, that is a blatant plug) looks like this:

![Wiki Screenshot](https://example.com/wiki-screenshot.png)

Notice that on the initial page you have the ability to switch between either a wiki or a blog, as circled on the screenshot above. Which you chose to use is entirely up to you. We assume you know a *little bit*
about the difference between the two, but here’s the distinction, according to Wikipedia which—given its name—has become quite the expert on the topic of wikis, at least:

**Blog:** A blog (a blend of the term web log) is a type of website or part of a website. Blogs are usually maintained by an individual with regular entries of commentary, descriptions of events, or other material such as graphics or video. Entries are commonly displayed in reverse-chronological order. Most blogs are interactive, allowing visitors to leave comments and even message each other via widgets on the blogs and it is this interactivity that distinguishes them from other static websites. [*Excerpted from http://en.wikipedia.org/wiki/Blog on July 26, 2011.*]

**Wiki:** A wiki is a website that allows the creation and editing of any number of interlinked web pages via a web browser using a simplified markup language or a WYSIWYG text editor. Wikis are typically powered by wiki software and are often used collaboratively by multiple users. Examples include community websites, corporate intranets, knowledge management systems, and note services. The software can also be used for personal notetaking.

Wikis serve different purposes. Some permit control over different functions (levels of access). For example editing rights may permit changing, adding or removing material. Others may permit access without enforcing access control. Other rules can be imposed for organizing content. [*Excerpted from http://en.wikipedia.org/wiki/Wiki on July 26, 2011.*]

Basically, a blog is going to be posted by you (the faculty member) in reverse chronological order, though your students could post comments to each entry. More importantly, if you choose to do any podcasts, they will automatically appear on a blog.

**Wikis** are intended for more collaborative products, though you can control how that collaboration is done. In fact, you can administratively set a wiki so that no one can comment, anyone in the world can comment, or only authenticated users (i.e., your students) can comment. You can also choose to moderate (meaning, check them over before they are posted) all comments, no comments, or only anonymous comments. Unlike blogs, wiki postings appear as separate pages rather than one long page in reverse chronological order.

While it is not crucial to be an HTML expert, it does not hurt to have some knowledge in some instances in order to get “just the right look” on a posting.

**Note:** Both of our learning management systems have Blog capabilities for the course site. Blackboard also has a Wiki.

### Podcasts

First off, let’s get rid of a bit of confusion: one does NOT have to have an iPod® to listen to or view a podcast. Just because you choose to create a video podcast of an oral presentation in class does not mean that only those students who have an iPod will be able to view it. They will be viewable on a computer, just like audio-only podcasts are able to be listened to on a computer. Let’s rely on Wikipedia again to provide a brief definition of what a podcast is:
Podcast: A podcast (or non-streamed webcast) is a series of digital media files (either audio or video) that are released episodically and often downloaded through web syndication. The mode of delivery differentiates podcasting from other means of accessing media files over the Internet, such as direct download, or streamed webcasting. A list of all the audio or video files currently associated with a given series is maintained centrally on the distributor’s server as a web feed, and the listener or viewer employs special client application software known as a podcatcher that can access this web feed, check it for updates, and download any new files in the series. [Excerpted from http://en.wikipedia.org/wiki/Podcast on July 26, 2011.]

There are two types of podcasts: video and audio. If you want to do a video podcast, two things will have to happen. First, you must request a class blog, as outlined in the above section. That’s because podcast productions will be posted to that class blog in reverse chronological order. Secondly, for those times you want to video record something as a podcast, you will have to make an equipment request through the IT help desk at ext. 6888 (708-524-6888 from off-campus) AND must have received training in the use of the equipment as well as the logistics involved with getting things posted onto your class blog. There are no exceptions to this rule. The equipment delivered will include an Apple Macintosh laptop. Creating a video podcast is really the only time you will have to actually use an Apple Macintosh to create content. (Simply using and editing a blog or wiki can be done on any PC, since both are completely web-based.) Once you get the camera rolling, it can be produced as a podcast.

The First Commandment of Video on the Web: Thou Shalt Not Create Long Lectures, Else Your Students Shall Curseth

Not only is it a strain on you to create videos that last 50, 60, or even 90 minutes, it’s a strain on your students and on our server. Do you REALLY think they are going to watch a video that long online?? What if they have to stop it midway? It’s rather difficult to “cue it up” to the exact spot where they stopped it last. It is therefore strongly encouraged that you divide up your lecture into, say, 10- or 15-minute snippets and upload each separately. If you don’t believe us, check an article that appeared in The Chronicle of Higher Education called “Short and Sweet: Technology Shrinks the Lecture” in the June 20, 2008 issue on page A9. It’s available online through the library’s databases, in Academic Search Premier, among others.

For audio podcasts, things are a bit easier. While you can still use a cart with a Macintosh computer for direct uploading onto a blog, you can also record something using your own PC so long as you have a microphone. Upon request, Information Technology can install on your office computer a free product called Audacity. In order to convert Audacity files into MP3 audio files (the preferred file format for audio on the web), a so-called LAME MP3 encoder also has to be downloaded. Once that’s done, it’s really as easy as pressing the RECORD button in Audacity and recording your file with a microphone, and then saving it as an MP3 file. The resulting MP3 file can then be uploaded onto a podcasting blog OR you can simply upload it to a course site like myDU or elsewhere.

By posting a podcast on a blog, users can subscribe to the blog using a “feed reader.” Commonly used feed readers include iTunes (a free download, and you do NOT have to be using an Apple) as well as several others on the web. Additionally, the latest version of Outlook includes an RSS Feeds folder where any RSS feeds you subscribe to can be found. However, an audio file does not necessary have to be a “podcast” in the strictest sense of the word. If you just take an MP3 file and upload it to myDU or Blackboard, your students will still have an audio recording. They just won’t be alerted automatically via a feed, as they would with a blog posting.

IT Help Desk: ext. 6888 (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. Information Technology staff will NEVER ask you for your user name or password via email.
Taking Over Student Machines

This sounds more nefarious than it is. By this we mean the instructor's ability to "project" whatever is on their machine directly onto the student's machine in the classroom. And yes, you can even prevent students from doing things like surfing the web temporarily. All computer classrooms (see page 31, below) have a software product called Net Ops Teacher that allows the instructor to...well, "take over" the student's computers. If you want to use this software, Information Technology can provide you with a brief overview, assuming the classroom is available. (For that reason, it's best to schedule an appointment well ahead of time.) Ken Black, Teaching and Learning Technologies, also knows this software, so if you're over in Parmer Hall he can give you an overview as well, so long as you schedule this in advance (and the room is available).

SmartBoards

Some rooms are equipped not with pull-down screens for projection, but SmartBoards. SmartBoards are available in: Fine Arts 114, Fine Arts 212, Lewis 305, Parmer 432, and Priory 270. While they DO project, they can also be used for things like saving what you "draw" on the screen and other uses. There is a sheet of instructions available in the rooms that help explain this feature.

"Clickers"

More properly called "classroom response systems," Information Technology has three sets of clickers, one with 30 clickers, and the other two with 25. (These can be combined for larger classes.) They are available to loan out to faculty members upon request. There are a few competing brands out there, and we have settled on the ones produced by Turning Technologies, given its easy integration with PowerPoint and the ability to create "on-the-fly" questions during a presentation.

Classroom response systems allow students to use handheld devices to respond to questions posed by the faculty member. The faculty member, in turn, can see immediately the responses on a chart embedded on a PowerPoint slide. It is a terrific way to not only assess if your students understand material (based on the assumption that students nodding their heads in class is not the best way to assess this), but is also a good way to gauge what students think about (for example) controversial topics that they might not otherwise want to respond to directly in class.

To prepare for a class where you intend to use these, contact the IT Help Desk to also have the TurningPoint software installed on your office PC AND in the classroom you teach. (You can also download it for free from their web site at www.turningtechnologies.com if you want a copy at home.) This is very important, because you have to have this software running in the background while creating the PowerPoint slides when you wish to use the response devices. If you know how to use PowerPoint, you will find the add-on software very easy to use. Plus, IT has the complete manual in a three-ring binder available along with the clickers. Additionally, there is new TurningPoint Anywhere software that does NOT require PowerPoint at all to use, though you also lose the ability save the student answers as effectively had you incorporated it in PowerPoint.

Requesting "Clickers"

Submit an IT Help Desk ticket at least two weeks in advance of when you plan to pick up the classroom response devices, as their availability can otherwise not be guaranteed. In addition, IT will have to ensure the room you are planning to use has the correct software. There is some documentation online.
on the IT page on myDU by clicking on **Forms and Information** (on the far left). On the ensuing page, scroll down and on the right there is an area called Instructional Technology Help.

**Cart of iPod Touches**

IT has a cart of 18 iPod Touches that are available upon request by an instructor with at least two working days’ notice. This cart is used primarily for courses that do mobile programming, but these could be used in any class where you will be accessing web sites that are mobile-ready. (If you want a specific app loaded on them, please allow **2 weeks** for this, and submit an IT Help Desk ticket.)

**Cart of Laptops or Netbooks**

If you are teaching in **Parmer Hall** (only) there is a cart of 18 laptop computers available for those classes that are not already in a computer classroom. Submit an IT Help Desk ticket requesting this cart at least two working days ahead of time.

**Lewis Hall** has a cart of 18 netbooks available. (Meaning they are mostly good for accessing the web and little else.) Again, submit an IT Help Desk ticket requesting this cart at least two working days ahead of time.

**Other Video Options**

**Camtasia Studio**

Podcasting is not the only video-based capability we have. Dominican has a **limited number** of licenses to a product called **Camtasia Studio** which allows you to do two major things:

- Record audio narration over an existing PowerPoint presentation and then convert it into web-friendly Flash output (as well as several other outputs, including the **m4v** output for iPods), **and**
- Capture actual screen shots on your computer **while recording audio narration**. This is especially useful when demonstrating specific software products for your classes or showing a web site.

For either of these you will also, of course, require a microphone. Both of these installation requirements unfortunately limit this at the moment to full-time faculty unless special arrangements can be made. Contact IT for software and microphone installation.

Briefly, if you plan on producing video files using **Camtasia Studio**, the latest version offers the popular **MP4** format now favored by **YouTube**. This is also the best format to use for longer video files. (Bear in mind "longer" means 10 minutes or so, NOT hours long! See the previous page’s **The First Commandment of Video on the Web**.) **Camtasia** will usually produce multiple files that must then be “zipped” together with a Flash-based player control. Because of the necessity to “zip” up files, they can therefore only be placed directly into a Blackboard course site, since myDU cannot “unbundle” zip files in the same manner as Blackboard. However, you can also simply place these files into folders on your I: (web) drive, and then create hyperlinks to them from within your myDU site. **Camtasia** can also produce single-file SWF-type Flash files to post on myDU, so can get by with posting only the MP4 file from your production and post it on myDU, though without the fancy "play" buttons or table of contents that the multiple-file version produces.
Don’t worry—all of this is not quite as complicated as it sounds!  *Camtasia* itself is fairly easy to master, it’s just that the resulting *Flash* files require a bit of housekeeping after the fact to get them ready to use on a course site.  *Camtasia* is constantly upgrading their product.  We have complete documentation available through (where else?) the *Information Technology* page on *myDU*, and then by clicking the *Forms and Information* link on the left, and then scrolling down until you see the section called *Information Technology Help*.

### Video Cameras

Information Technology has a limited number of video cameras available to loan to faculty.  These are not the high-definition type of cameras, but smaller-size, handheld devices that are perfect if you wanted to (for example) interview a colleague or even post a guest lecture on your site.  As always, contact Information Technology at least two working days before you need it.

### Web Conferencing

Beginning Fall 2010, Dominican purchased a limited license for the web conferencing system *Elluminate*.  *Elluminate* was purchased by Blackboard, and it is now called *Blackboard Collaborate*.  However—this is important—you **DO NOT** have to be a *Blackboard* user to use this product!  It is a **stand-alone product** that just happens to be owned by *Blackboard*.  (Kind of like how you don’t need to be on an Apple computer to download *iTunes*.)  This system allows you the ability to conduct synchronous, web-based class sessions with your students.  While ideal for online courses, it can also be used for any purpose where you would need web conferencing capability.

This is **not** software that you just want to sit down and try out a few hours before class!  While reasonably easy to use, a certain amount of expertise is necessary before using this system.  For that reason, we have a training requirement in order to use the software.  Contact Information Technology if you are interested in hosting a class using web conferencing; though be aware you want to give yourself plenty of time to get up to speed on the software—likely about two weeks, given the training requirement.  You will also the requisite hardware (headset with microphone).

### Software Information

#### What Software Packages Does Dominican Support?

We presently support *Outlook* for our email system and the *Office* suite for individual desktop applications (*Word*, *Excel*, *PowerPoint*, and *Access*).  All personal computers in faculty offices, the Technology Center and other labs, and computer-equipped classrooms should have these programs.  (Newer machines distributed beginning in fall 2011 will have *Windows 7/Office 2010*; older machines will have *Windows XP/Office 2007*.)  There is also a virus-scanning program installed on every PC, *Symantec Antivirus*, commonly called “Norton.”  (We’re still waiting for a competitor to call themselves “Ralphie Boy.”)

So what does “support” mean?  It means if something goes wrong with one of these packages, IT will do its best to find a solution to the problem.  It also means if you have a question about a specific aspect of one of these packages, that they will try to find an answer to that, too.  It does **not** mean that there will always be time to answer questions regarding how to use a product from the ground up.  (Such as:  “I
have to do a *PowerPoint* presentation for a meeting in an hour, and I have no idea how to even get started! ”) For those purposes, there will be several IT workshops offered throughout the academic year dealing with specific software products. Keep your eyes on the Information Technology pages on *myDU* for their *TechU* training sessions. Teaching and Learning Technologies in the Borra Center for Teaching and Learning Excellence also has workshops on specific technologies for the classroom, such as *Camtasia Studio*, *myDU* and *Blackboard*, and clickers.

Also note that there are many times that faculty members want specific software packages placed on a server or on individual PCs (for more on that issue, see below). While we will do our best to assist faculty with those products when something goes wrong, we cannot offer assistance specific to functions within that product. (If you *wanted* the specific product purchased for the University, we assume that you know how to *use* it or will teach yourself!)

### How to Learn More About Supported Software Packages

IT has several workshops throughout the academic year, and this is your best opportunity to learn more about our supported software, such as the *Office* suite of products. Go to the Information Technology area of *myDU*. There is an area called Training and Workshops right on the main page, via a link on the left. We will also send out email announcement on these training opportunities.

Teaching and Learning Technologies has workshops that will be listed on the Teaching and Learning Technologies page within the CTLE's site under Resources→Center for Teaching and Learning Excellence. These workshops cover classroom technologies such as *myDU*, *Blackboard*, *Camtasia Studio*, and others.

### What Software Is Loaded Where?

As mentioned earlier, *Office 2007* is virtually everywhere, though *Office 2010* is slowly but surely getting deployed to individual desktops as well as the labs. For other applications in the Technology Center specifically, contact the IT Help Desk at ext. 6888 (708-524-6888 from off-campus).

### How to Get Specific Software Needed for a Class

It is extremely important that you inform Information Technology about this as soon as possible—and that does not mean only a week before you need it. To start with, fill out a Faculty Software Request Form. This is available on Information Technology’s *myDU* page by clicking Forms and Information over on the left, and you will see a link to Faculty Software Request Form on the resulting page. Or you can also get the ball rolling by submitting an IT Help Desk request (see the end of this document). Before doing either, ask yourself the following questions:

- Does my department have the funding to purchase this software?
- How many licenses will be needed for this installation?

The last one is critical. IT will NOT simply take a disc and start installing as many copies as you deem necessary. We are not anxious to be visited by the Business Software Alliance for a licensing violation anytime soon!

### How to Obtain Copies of Software or Computers for Personal Use

Our licensing does *not* support the use of personal copies of software. As a faculty member of an educational institution, however, you are in a position to take advantage of some massively discounted
software packages that many software manufacturers give to faculty, staff, and students through local computer stores or over the web.

For *Office*, the least expensive route is through our arrangement with VarsityBuys. To find out how, be sure to LOG IN to *myDU* and click the link for **Discounts Available** over on the far left of the IT page. To purchase software, be sure you have a Dominican email address and a current faculty ID—you may be asked to scan and email the latter. If it’s something other than *Office* you are after, odds are there is an academic software discount somewhere. Typing in the keywords **academic software discount** in *Google* will generate pages and pages of hits. Be careful, though, as some of these can be less than legal, but sites such as CDW-G or Academic Superstore are legitimate.

For computer hardware, Dominican has a nice deal going with both Dell Computers (for PCs) and Apple (for Macs). Information and links to both are on the same Information Technology page sited above. While we’re not talking half-price or anything quite so drastic, the savings can still be significant when compared to those not enlightened enough to be working in the field of education.

Though Dominican has *Office 2007* installed on most office machines, academic discount vendors now offer only the latest version, *Office 2010*. Fortunately, the file formats for these two versions are the same, though *Office 2010* has some new features.

### Computer Classrooms

#### How Do I Get a Computer to Use in the Classroom Just for Myself?

This depends on how often you will need use of the computer. If you plan on using a computer virtually every class meeting, then you want to make arrangements ASAP with the Office of the Registrar at ext. **6774** (708-524-6774 from off-campus) to get an Enhanced Learning Environment Classroom. These classrooms have a networked personal computer, screen, projector, sound system, and VCR and DVD player. These rooms get booked very quickly. The following classrooms are equipped in this manner.

<table>
<thead>
<tr>
<th>Enhanced Learning Environment Classroom(s)</th>
<th>Additional Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crown</td>
<td><strong>ALL</strong> Third-Floor Classrooms; Crown 330 also has computers for students (see below)</td>
</tr>
<tr>
<td>Fine Arts 010</td>
<td>Instructor's station is dual-boot (PC/Mac)</td>
</tr>
<tr>
<td>Fine Arts 114</td>
<td></td>
</tr>
<tr>
<td>Fine Arts 212</td>
<td></td>
</tr>
<tr>
<td>Lewis 204</td>
<td></td>
</tr>
<tr>
<td>Lewis 301</td>
<td></td>
</tr>
<tr>
<td>Lewis 302</td>
<td></td>
</tr>
<tr>
<td>Lewis 310</td>
<td></td>
</tr>
<tr>
<td>Lewis 312</td>
<td></td>
</tr>
<tr>
<td>Lewis 334</td>
<td></td>
</tr>
<tr>
<td>Parmer</td>
<td><strong>ALL Classrooms</strong>; Parmer 003, 004, 114, and 428 also have computers for students (see below)</td>
</tr>
<tr>
<td>Priory 259, Prior 261, Priory 270</td>
<td></td>
</tr>
</tbody>
</table>

IT Help Desk: ext. **6888** (708-524-6888 from off-campus) or visit web site listed on top of page to submit help ticket. **Information Technology staff will NEVER ask you for your user name or password via email.**
If this is an “occasional use” request, then you will want to contact the IT Help Desk at ext. 6888 (708-524-6888 from off-campus) to reserve a laptop computer on a media cart for your classroom along with any other media equipment you may need. These also tend to go quickly depending on the time of day the class is offered, so be sure to reserve yours soon!

How Do I Get a Classroom With Computers for Each of My Students?

Dominican has 10 Windows-based classrooms, one predominately Macintosh-based classroom, and one mixed environment that are equipped so that each student has a personal computer (as does the instructor) with the instructor’s also hooked up to projector and room-wide sound system. Except as noted below, all of these rooms also have DVD drives along with CD-ROM burners. These rooms get booked very quickly, too, so be sure to notify the Office of the Registrar at ext. 6774 (708-524-6774 from off-campus) to check availability. The rooms that are equipped in this manner are listed below:

<table>
<thead>
<tr>
<th>Crown 111</th>
<th>24 student computers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Crown 202</td>
<td>20 student stations, dual boot capable with Windows XP and Mac OS X; as is instructor’s computer.</td>
</tr>
<tr>
<td>Crown 330</td>
<td>31 student computers</td>
</tr>
<tr>
<td>Lewis 002</td>
<td>30 student computers; dual-boot (PC/Mac)</td>
</tr>
<tr>
<td>Lewis 004</td>
<td>25 student computers; dual-boot (PC/Mac)</td>
</tr>
<tr>
<td>Lewis 130</td>
<td>21 student computers; 2 instructor’s computers; NO CD-ROM burners</td>
</tr>
<tr>
<td>Lewis 131</td>
<td>18 student computers</td>
</tr>
<tr>
<td>Lewis 406 (Digital Media Classroom)</td>
<td>21 student Macintosh computers; 4 student PCs; instructors’ computer is Mac-based</td>
</tr>
<tr>
<td>Parmer 003</td>
<td>26 student computers</td>
</tr>
<tr>
<td>Parmer 004</td>
<td>30 student computers</td>
</tr>
<tr>
<td>Parmer 114</td>
<td>30 student computers</td>
</tr>
<tr>
<td>Parmer 428 (Assistive Technology Lab/Classroom)</td>
<td>16 student computers</td>
</tr>
</tbody>
</table>

Also, if you happen to be teaching in Parmer Hall, Information Technology has a cart of up to 18 laptop computers that can be distributed to a class. They also have a cart of 18 iPod Touches, which have been used in classes that cover mobile applications.

Information Technology is NOT in charge of any of the classrooms listed above, although they do, of course, provide technical assistance in their use. You MUST go through the Office of the Registrar to reserve classrooms!
IT Help Desk Web Site

In addition to the phone number you see on every page of this document, please note that you can also submit a request to the IT Help Desk over the web. If you go to the web site listed on every page of this handout, the very first link you see is to contact the IT Help Desk, which leads to a web page like this:

```
Dominican University IT HelpDesk

Please enter your Dominican email address and click the Login button.

If you are not a registered user, please register.

Dominican email address:

(e.g., jsmith@dom.edu)

Login

Call the Helpdesk: 708-524-6888
Email the Helpdesk: helpdesk@dom.edu
```

The **first** time you use this system, you will need to click the *register* link on the page, but you will only have to do that once. After that, your email address will be registered and you can submit help requests online. This site can be used for all manners of IT-related help requests.

Information current as of August 2011